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Tennis Australia has now allowed tournaments to be managed with CAT as long as the Tennis Australia 
requirements are met for the particular tournament - see below for this statement

Statement from Tennis Australia August 20 2009

--------------------------------------------------------------------------------------------------------------------------------------
From July 1 2009, Tennis Australia’s official tournament software for all Australian Ranking tournaments is 
now Tournament Planner by Visual Reality.  The Active Network will continue to be the official provider for on-
line entries, having formed a partnership with Tennis Australia and Visual Reality to provide the new regonline 
system.  It is now compulsory for all Australian Ranking tournaments to display the entries, draws, results and 
ideally the schedule via Tournament Planner (through the http://tournaments.tennis.com.au website) before 
and during the tournament.  It is also compulsory for all tournaments to offer players the opportunity to enter 
the tournament online via the Active Network system.  Under no circumstance should an alternative online 
entry system be used to administer entries into an Australian Ranking tournament.  
 
However, Tennis Australia will not penalise tournaments if they wish to utilise an alternative system in 
conjunction with Tournament Planner to administer the tournament (outside of online entries) as long 
as the requirements stated above are fully adhered to.  
 
Tennis Australia have invested a large amount of funding and resources into the development of the Tourna-
ment Planner and the Active Network system and we will be monitoring all Australian Ranking tournaments 
in 2009 and 2010 that all regulations are being followed.  Feedback on how the system can be improved on a 
national scale is also encouraged, as Tennis Australia will be releasing new versions of Tournament Planner 
throughout the year with upgrades and modifications.    
 
Training on the Tournament Planner system has taken place across the country over past few months with 
additional workshops to be conducted by our Member Associations when necessary.  Extra customer support 
will also be available through Tennis Australia and the relevant Member Association for tournament directors 
when using Tournament Planner over the next 12 months.  
 
The implementation of the Tournament Planner and Active Network systems is just the first step in our goal to 
help tournaments run more efficiently.  The future implementation of the My Tennis membership database will 
involve integration with Tournament Planner, allowing the automation of many processes within the current 
tournament setup phase.  
 
If tournament directors wish to discuss any matters in relation to Tournament Planner and the requirements 
for Australian Ranking tournaments, please contact Francis Soyer at Tennis Australia on (03) 9914-4198 or 
e-mail: fsoyer@tennis.com.au 
---------------------------------------------------------------------------------------------------------------------------------------------

This gives Tournament Directors a choice and if they want to use the advanced scheduling  and tournament 
management tools available in CAT.  Tournament Planner at this stage does not have “all the bells and whis-
ltes” that CAT has when it comes to scheduling tournaments.  Result entry is also much faster using CAT 
match numbers.  During the next 12 - 24  months I will be working with Tennis Australia and the ITF se-
niors in London providing feedback on how TP scheduling can be improved towards the capabilities of CAT.

To facilitate the transfer of data between TP and CAT the following features have been developed ;



CAT  will now export and import data to and from Tournament Planner.  

The exports are all managed through the use of Microsoft Excel spreadsheet software to provide the link 
via csv files - csv files hold the information in a standard format, which is readable by CAT and Tournament 
Planner with the information separated by commas.  All events in TP must be numbered with the same 
numbering as in CAT eg  1 Mens Open Singles,  2 Womens Open Singles etc.

Export from CAT 

All player entry details can be exported to Tournament Planner as well as the event entry details and 
doubles partners.   Unfortunately there is no export available for draws or match results as Tournament 
Planner at this stage does not have the requirement importing capabilities.  To satisfy Tennis Australia re-
quirements draws will have to be duplicated in Tournament Planner and results entered and duplicated in 
Tournament planner as well.

Export Steps in Brief 

Player Events
1. CAT  - Create event lists export - Player Entries/Print/Event Lists/Tmnt Planner Export  - entriestp.txt
2. Excel  - Create entriestp.xls
3. TP - Players - Import Entries - Nominate each event. - players and event data imported.

followed by;

Player Entries Data
1. CAT - Utilitites  - Export/Import - Tournament planner (TP) Export -  Export - Create tplanr.txt
2. Excel - Convert tpanr.txt to tplanr.xls
3. TP  - Players - Import Entries - select no events - All players data imported.

Import into CAT 

All player entry details can be imported from Tournament Planner as well as the event entry details and 
doubles partners.  In addition event draws if created in Tournament Planner  ( ie the standard knockout 
draws currently ) can be imported into CAT from Tournament Planner.

Import Steps in Brief 

Player Entry Details
1. TP  -  Reports - Players - Players - select players then correct fields - create mytournament .xls for example
2. Excel  - Create tplanr.csv
3. CAT - Utilitites - Export/Import - Tournament Planner (TP) Import - Players Data - Import

Doubles Partners
1. TP  -  Reports - Entries - Entries - select doubles events and name only - create entriesmytournament.xls eg.
2. Excel  - Create tpevent3.csv, tpevent4.csv etc
3. CAT - Utilitites - Export/Import - Tournament Planner (TP) Import - Doubles partners - Import

Event Draws
1. TP - Draw - Layout - no ticks - then Draw - Export to Excel - create mytournamentdraws.xls
2. Excel - Create todraw1.csv, tpdraw2.csv, tpdraw3.csv etc.
3. CAT -  Utilitites - Export/Import - Tournament Planner (TP) Import - Event Draws - Import

See the following pages for detailed  importing and exporting procedures.



 
CAT exports to Tournament Planner 

Exporting CAT Player Entries data to Tournament Planner 

Step 1 of 2

CAT - Exporting CAT Event Data

Tournament Planner only allows importing of the data one event at a time. You can either create one export file en-
triestp.txt if you export all events or you can make one at a time files for each event entriestp1.txt, entriestp2.txt and 
so on by selecting an individual event and exporting each one.
In CAT Player Entries go to Print and then select Event Lists . 
In the Include section tick the Tournament Planner Export, (Tment Planner Export)  select either all events or an 
individual event and then click the Export button. This will create a file entriestp.txt or if individual event selected 
entriestp#.txt where # is the CAT event number ,in the export folder of your CAT tournament folder  eg c:\cat\
export.

Excel - Create Excel files
Exit CAT and start Excel and go to open and select all files and select the file entriestp.txt. When opening this file 
indicate the file is delimited and by commas then the file appears in excel. In Excel go to Save as and save as an excel 
1997-2003 file eg entriestp.xls. Tournament planner at this stage does not support Excel 2007.

You then have two choices if you export all the events as one file - You can leave the file as it is as one excel file or 
you can make different excel files for each event.  If you leave the file as one excel file with all the entries in all the 
events when you are importing into Tournament Planner you have to import each event one at a time and tick just 
the players on the list in the event you are importing. If you have exported one event at a time then open each txt 
file in excel and save as an excel 2003 worksheet.

Tournament Planner - Importing CAT data  
* Make sure you have a backup before attempting any imports.
In Players menu select Import Entries and browse to the name of the excel file eg entriestp.xls and then select Open.  
Then click the next button and make sure the Name and First name fields align with the data from the spreadsheet 
and click next. On the next screen mentioning fields leave all entries blank. On the next screen with the heading 
result make sure the correct players are ticked for the event you wish to import. Use the None button to take all the 
ticks off and then tick the required players. Then click Next and tick the required event and click Finish. All the players 
will be imported into the nominated event. Continue until all the events have been imported from CAT.
Note : If the event is doubles you can get TP to match up the partners, provided they are allocated in CAT.  When 
selecting a doubles event on the last screen make sure you tick Link partners in odd and even rows.

Step 2 of 2 

CAT - Export all Player Data

In CAT go to Utilities and Export/Import Utilities, Export/Import Utilities again and select the second format on the 
list Tournament Planner(TP) export.  You may then set this as a default using the button lower down in this section.  
Click the Export button and CAT will create another file in the export folder called tplanr.txt.    Exit CAT.

Excel - Create Excel files 
Open Excel and browse for the file tplanr.txt and open the file which is delimited with commas. Make sure in step 
3 of 3 of the wizard you assign the data type of date to the date of birth column. Open this file and then 
save as an excel 1997-2003 file for example  tplanr.xls.

Tournament Planner - Importing CAT data
In Players menu select Import Entries and browse to the name of the excel file eg tplanr.xls and then select Open.  
Then click the next button and make sure the all the fields align with the data from the spreadsheet and click next. 
ON the next screen regards fields leave all entries blank. On the next screen with the heading result make sure all 
players are ticked  which is the default. Then click Next and do NOT tick any events and click Finish. All the players 
will be imported importing all the extra data from CAT  eg phone numbers , emails , addresses etc.



Tournament Planner Imports into CAT

Importing Tournament Planner Players Data  into CAT Player Entries

Step 1 of 2 - Player Data

Tournament Planner - Create an excel file

In the Reports menu select Players then select Players again. On the select players screen select the players you 
wish to export. There are many options here the simplest being all players., but you could easily select just the lat-
est entries if you wish to progressively import data . Click OK when players have been selected.

On the Print Players screen remove all ticks on the fields then select the following fields;

Name
Firstname
Address
Address 2
Postal Code
City
Phone Home
Mobile
E-mail
DOB
Gender
Club
Ranking 1
Num, Events
Events

When all selected click the Excel button and save this file as an excel sheet. with the name of your tournament as 
part of the filename  eg mytournament.xls.  Take note of where the file is being saved for the next step.

Excel - Create the CAT import file  tplanr.csv.

Open the file created above in Excel.  In the File menu of Excel go to Save as and select file of type  
CSV ( comma delimited) (*.csv) and in the file name enter tplanr.csv. 
Navigate in the save in box at the top to your cat tournament export folder eg. C:/cat/export and save the file in 
this folder clicking okay to any messages from excel about losing formatting features.

CAT - Importing Tournament Planner Data

Make sure you have a backup before attempting any imports. Also make sure the events in Tournament Planner  
have the event number the same as expected in CAT.  eg 1 Open Mens Singles

In CAT go to Utilities and Export/Import Utilities, Export/Import Utilities again and select the first format on the 
list Tournament Planner(TP) import and also the top radio buttonin TP imports Players Data.  This format  can be 
saved and set as default if required.  This import only indicates two events but because of the way the TP data is 
exported this import will bring in any number of events from 1 through to 6 events the maximum in CAT. 

Click the Import radio button at the bottom right to show as green and then click the Import button. Click YES to 
import the data .

CAT will then import all the players data from the csv file. If a player is found already in CAT you are given the op-
tion to press X to ignore this player or if they are in fact a similar player with a system name already entered you 
can change the initial to add the player to the CAT tournament.

At the end of this process go to Player Entries and check the entries are there.  



Importing Tournament Planner Players data  into CAT Player Entries

Step 2 of 2  - Doubles Partners

Tournament Planner - Create an excel file

In the Reports menu select Entries  then select Entries again. On the select events screen select all the doubles 
events you wish to export.  On the Select Fields on the right only tick the name field. Make sure the names  are set 
in TP as given name and surname  with no middle names.  

When all selected click the Excel button and save this file as an excel sheet. with the name of your tournament as 
part of the filename  eg entries of mytournament.xls.  Take note of where the file is being saved for the next step.

Excel - Create the CAT import files  tpevent#.csv where # is the event number eg tpevent1.csv.

Open the file created above in Excel and you will see each event ins in a different sheet along the bottom menu. Go 
to the first sheet then in the File menu of Excel go to Save as and select file of type  CSV ( comma delimited) (*.csv) 
and in the file name enter tpevent3.csv, if you are saving say Event 3 Mens Open Doubles. Navigate also in the save 
in box at the top of this window to your cat tournament export folder eg. C:/cat/export and save the file in this 
folder clicking okay to any messages from excel about losing formatting features.

Continue for each doubles event by clicking the next sheet and saving as a csv file remembering each time to add 
the event number at the end after tpevent.

CAT - Importing Tournament Planner Doubles partner data

Make sure you have a backup before attempting any imports.  

In CAT go to Utilities and Export/Import Utilities, Export/Import Utilities again and select the first format on the list 
Tournament Planner(TP) import.  In addition in the TP imports section select the doubles partner radio button. 

Click the Import radio button at the bottom right to show as green and then click the Import button. Click YES to 
import the data.

You are then asked which event number to import so in our example you would enter 3 and then you are asked to 
confirm you wish to import the doubles partners for tpevent3.csv

CAT will then import all the players doubles partner data from the csv file and match up the doubles partners au-
tomatically.  Player who do not have a partner will have the event number and Preqd placed in their CAT comment 
filed. If a player is found  in CAT and they are not entered in the event this entry will not be added. 

At the end of this process go to Player Entries and check the entries are there.

Continue with all the doubles events as created in the Excel section of this import.



Tournament Planner Imports into CAT

Importing Tournament Planner event draws into CAT

You must have closed entries in CAT to import event draws.

Tournament Planner - Create an excel file

In the Draw menu select Layout and take all the ticks off in the column  area leaving the Header as Standard. Tick all 
the draws on the left hand side with the all button. Then click OK.

In the Draw menu again go to the bottom and select export to excel and save all the draws giving this file a name ;
 eg  mytournamentdraws.xls.  Take note of where the file is being saved for the next steps in Excel. 
If asked to show timetabled matches click no.

 

Excel - Create the CAT import files  tpdraw#.csv where # is the event number eg tpdraw1.csv.

Open the file created above in Excel and you will see each event is in a different sheet along the bottom menu. Go to 
the first sheet then in the File menu of Excel go to Save as and select file of type  CSV ( comma delimited) (*.csv) and 
in the file name enter tpdraw1.csv, if you are saving say Event 1 Mens Open Singles. 
Navigate also in the save in box at the top of this window to your cat tournament export folder eg. C:/cat/export 
and save the file in this folder clicking okay to any messages from excel about losing formatting features.

Continue for each  event by clicking the next sheet and saving as a csv file remembering each time to add the event 
number at the end after tpdraw.  i.e. tpdraw2,csv,  tpdraw3.csv etc.

CAT - Importing Tournament Planner Event Draws.

Make sure you have a backup before attempting any imports.  

In CAT go to Utilities and Export/Import Utilities, Export/Import Utilities again and select the first format on the list 
Tournament Planner(TP) import.  In addition in the TP imports section select the Event Draws radio button. 

The Import radio button at the bottom will show as green and then click the Import button. 

You are then asked which event number to import so in our example you would enter tpdraw1.csv

CAT will then import the event draw from the csv file.  You can then do further imports and or go to View / Edit 
Event Draws in CAT to check the draws have imported correctly.


